USING A DIGITAL CAMERA AND EDITING SOFTWARE
By Tony Manton
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Setting your camera up to take the very best pictures
Out of the box, a digital camera may not be set up to take the best possible
pictures.
The resolution (the number of pixels used in the picture) should be set at
maximum.
Compression (the amount by which the picture is reduced in size) should be
set to the lowest compression or fine setting. This will result in larger file
sizes and fewer pictures stored on your memory card, but with the ever
falling price of memory cards, this should not be a problem.
Set the white balance to automatic (this can be changed for specific
situation which will be discussed later).
If the camera has it, set the anti shake, also know as image stableitation to
on.
Whilst the Auto setting is OK for many situations and will produce acceptable
pictures most of the time, the Program setting gives more flexibility to
adjust things like aperture and shutter speed, focussing area and light
metering patterns – again, more of these later.
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Taking the best possible picture in the first place will reduce the work that
needs to done later.
A picture that is of average quality can be improved, but getting the original
picture right in the first place is much better.
Low resolution and high compression pictures will be of poor quality – you
cannot add more resolution (low resolution pictures have little detail), or get
rid of the effects of high compression (blocky pictures with poor colour
graduation).
Whilst it is a good idea to set the flash to Auto, in some situations this will
make the picture worse. For instance, trying to take a picture in a stadium, or
anything at a distance at night is difficult, but the flash will not help at all.
The built in flash on most cameras has a range of just 3 to 4 metres (10 to 13
feet). Because the camera thinks the picture will be lit with the flash, it
adjusts the exposure accordingly, resulting in a very under exposed picture.
In these situations, the flash should be turned off.
Also, turn Red Eye off. Using red eye makes the camera set off a pre flash,
which delays the actual taking of the picture. This can make your subjects
strain to keep smiling, or move after the first flash. Any red eye can easily
be removed later on your PC. The picture will be taken sooner after pressing
the shutter button, leading to a more natural picture.

Improving your chance of getting a great picture
Before setting out for a photo session, it is a good idea to check a few things
in advance.
Make sure the battery is fully charged. If you are going to be out for a long
time or taking a lot of pictures, it’s a good idea to buy a second battery (and
always have it fully charged too) and a second memory card, if your main one
is not very big (2gb or less).
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Clear any pictures from the memory card, using the FORMAT option (having
transferred them to your computer first!) so that you have plenty of room to
take lots of pictures.
Digital pictures cost nothing, so take lots.
Clean the lens, a dirty lens can ruin any picture and smudges, dirt and finger
prints cannot easily be removed and will be on every picture you take. Use a
soft lint free cloth such as used to clean spectacles. The glass in a lens is
relatively soft, so make sure there is no grit on the cloth before you use it.
This is particularly true if you are using the camera on a Smartphone as it is
very easy to get finger marks on the lens in general use.
When you press the shutter button on a digital camera, a number of things
happen. The camera looks at the amount of light available, what kind of light
it is (natural sun light, tungsten, florescent, snow/beach, sun set/sun rise and
so on). It also adjusts the lens for the best focus. The camera shutter
button has two positions, although you might not be aware of this to start
with.
Press the shutter button gently and you will find that the button moves
slightly and then meets with a little resistance. This is the position where
the camera makes all its adjustments.
On some cameras, there will be a short beep to show that everything is set,
on others there may be a small square in the middle of the screen/viewfinder,
which will turn green when it is set, and red or orange when it is not, ie too
dark/light or not focused.
If the shutter button is just jabbed fully down in one go, the camera will not
have time to do is work and result in an out of focus, poorly exposed picture.
Jabbing also shakes the camera, which may blur the picture too.
Practice squeezing the shutter button so you can feel the resistance point so
that you are used to doing it all the time. Your pictures will benefit.
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Sometimes, if the button is pressed down in one go, the camera will not take
the picture immediately, while it does its measurements. This can result in a
delay between pressing the button and taking the picture of up to one second,
resulting in the possibility of missing the picture you wanted.
When you press the button half way and the camera is ready, pressing down
the rest of the way will result in the camera taking the picture immediately,
so you get exactly the picture you want, properly focused, and exposed, with
the right colour balance.

Transferring your pictures to your computer and finding them again
Before transferring pictures to you PC, you should create a directory called
- My Pictures – then in the directory create another one each time you
transfer new pictures with the date or some other name that makes that set
easily identified.
Put a short cut to My Picture on your Desktop, by right clicking on the folder
and selecting Create Shortcut. Move the Shortcut to the Desktop by Right
Clicking and moving the mouse from the drive to the Desktop.
There are 3 ways to transfer picture to a PC 1) using the cameras supplied
USB cable 2) using a card reader and 3) some cameras now have the ability
to transfer pictures by WiFi - we will not be discussing this option here as
few cameras currently have this option.
1) Using the USB cable.
Most cameras are supplied with a USB cable and the manufacturers own
transfer & image manipulation software. This software varies from poor to
average. It is better to used software from dedicated imaging companies
such as Adobe Elements. Google’s Picasa is also very good but does not do as
many things as Elements, but is easier to use.
It is also not necessary to use the software to transfer the pictures as both
Windows XP, Vista, Window 7 and Windows 8 will do it for you.
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Open the My Picture folder and create the directory for you current batch
of pictures (eg Holiday 2014) and open that folder.
Connect the camera and PC with the USB cable.
Switch the camera on.
A small window will open with a disk drive letter, probably D: or E:
Go to the last but one option – Open Folder to View Files and select it and
click OK.
This opens a window of the pictures on the camera. Windows treats the
camera as if it is a new disk drive on the camera,
You will have to drill down through 2 or 3 folders to get to the pictures.
When you get there they will display as thumbnails or a list. If they appear
as a listing, select the View menu and click Thumbnails.
Now press - Control A – this selects all the pictures in the folder.
Press – Control C – if you want to copy the pictures, ie make a copy to your PC
and leave them on the camera or – Control X – if you want to move them, ie
remove them from the camera and put them on your PC.
Select you new folder (Holiday 2014) on the PC and press - Control V - this
will copy/move them from you camera to the new folder. It may take a few
minutes, depending on the number and size of the pictures.
2) Using a card reader or a built in card reader which many laptops now
have
Using a card reader is exactly the same as using a USB cable, except that you
remove the memory card from the camera and slot into the reader. The same
thing as above will happen, ie a new window will open with the card contents in
it.
Proceed as above for a USB cable.
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Finding your pictures again.
As there is a Shortcut on the Desktop, which you created earlier, all you need
to do is to click on it and it will open up with all the folders you have created.
Choose the folder with the pictures you want by clicking on it.
You can choose from a Film Strip (which also lets you view the pictures as a
full screen slide show, Thumbnails, and other view options.
Right clicking on any picture will give you lots of information about it. Select
Properties from the list.
Select the Summary tab (you can add your own comments to this page).
Now click Advanced
This window tells you all the technical details about the picture, including the
date and what type of camera was used.
All this without any additional software!
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Organising and Correcting less than perfect pictures
Downloading Picasa
Whilst commercial software such as Adobe Elements is very good, many of
the most useful tools for manipulating pictures can be obtained for free.
Google’s Picasa is one of the best.
To get, you need to open your internet browser. I use Microsoft’s Internet
Explorer.
Type - www.google.com - into the address bar and pres Enter.
Google’s home page will open.
Click on the More option at the top of the window.
Select Even More from the list.
About halfway down the page on the right column, you will find this logo
for Picasa.
Click on the Picasa word and new page will open. Click on the DOWNLOAD
PICASA 3 button and follow the on screen instructions.
Congratulations - you now have your free copy of Picasa.
Google also provide membership of a free space on the web to store a
limited number of your pictures, which you can keep private, share with you
family and friends, or with the whole world – you choose.
Using Picasa
Every time you start Picasa, it looks at your computer’s hard disk for any
pictures. The first time it may take a few minutes while it finds all your
pictures. During subsequent starts, it will just add any new ones.
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To learn how to use Picasa we will use the help and tuition that it has built in
to it.
Click the Help menu option across the top of the Picasa window. Select Help
Contents and Index F1. To get to help you can also just press the F1
function button, from within Picasa
Important : Before you start to make changes to any picture, make a copy –
that way, if you make a complete mess of things, by accidentally saving wrong
changes, you still have your original to go back to.
To make a copy, Right click the picture, and select copy.
Now left click away from the picture and right click again. Select Paste.
A copy will be created called Copy of the original picture name.
Select and click Getting Started Guide and off we go.
Note – what follows is taken from the Picasa web site, and therefore is
the copyright of Google. It can be viewed at any time by selecting Help
from within Picasa.
Getting Started with Picasa: Getting Started Guide
Using Picasa and Picasa Web Albums together, you can now organize, edit, and
upload your photos to the web from your computer in quick, simple steps.
Arrange your photos into folders and albums and erase their blemishes using
powerful editing tools in Picasa. Then use Picasa Web Albums to share those
perfected photos online with family, friends, and the world.
This guide walks you through the main features of Picasa. When you're done
perusing this guide, read up on Picasa Web Albums. You're then ready to
become an expert user of Picasa and Picasa Web Albums
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Organizing photos in Picasa
When you first install Picasa, it scans folders on your hard drive and displays
any detected photos. These folders, along with the customized albums you
create, make up the organization of your photos within Picasa. Within your
folders and albums, Picasa displays icons on your images to help you quickly
see which photos have been uploaded, marked as a favorite, geo-tagged, and
more.
Folders
Folders represent actual directories on your computer's hard drive that
contain photos. Changes you make to folders in Picasa affect corresponding
folders on your computer's hard drive. For example, moving a photo from one
folder to another in Picasa will also move the photo in Windows Explorer
(Windows) or Finder (Mac).
Mac users: Picasa handles the photos in your iPhoto Library a little
differently. To ensure that Picasa and iPhoto play nicely together, Picasa
scans and displays the photos in your 'iPhoto Library' as read-only files. If
you try to edit or move these photos, Picasa will ask your permission to create
a new editable copy. Learn more about how Picasa handles your iPhoto
Library, go to the help page.
Albums
Unlike folders, albums exist only in Picasa. For example, you might create an
album called 'Pictures with Grandma,' and include photos from various folders
on your computer. Unlike Picasa folders, your albums don't correspond to real
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folders on your hard drive -- so when you delete or move photos from an
album, the original files remain in their original locations on your hard drive.
Library icons
Picasa display small icons on your photos in the Library to provide you with ata-glance updates on the status of your image.
Click these icons to see short descriptions of their functions:

Importing your photos
Of course, not all your photos reside on your computer. You can import
photos into Picasa from many sources, including cameras, CDs, memory cards,
scanners, webcams, and more.
Follow these easy steps to import from your camera:
1. From within Picasa, click the Import button.
2. Select your device or folder from the drop-down menu (your camera should
automatically be detected). To help you import images from a particular day or
event, Picasa segments your images according to the time period in which they
were taken. Each group of images in the import window will be marked by a
clock icon.
3. Select the specific photos you'd like to import, or choose all. These photos
will be saved on your computer and displayed as a new folder in Picasa.
Quick and easy editing
Now that your photos are organized, you can start editing. With Picasa's
advanced photo editing, you can use basic one-click fixes to improve almost
any photo, adjust colour and lighting, and add effects like black and white or
sepia. Add captions to help tell the story.
First, double-click a photo to open the 'Edit Photo' screen. Then find your
editing tools on the left-hand side, within the three tabs Basic Fixes, Tuning,
and Effects.
Don't worry - Picasa never overwrites your original file. The photo edits you
make are only viewable in Picasa until you decide to either export or save your
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changes. Either way, your original photos are always safe and sound,
accessible at any time. Learn more.
Basic Fixes tab
Use the Basic Fixes tab to make simple edits on your photos.
Below are the basic fix buttons in Picasa:

Tuning tab
Control the colour and adjust the lighting in your photo to produce a more
visually enhanced image. Click the magic wands for lighting or colour
to
let Picasa automatically adjust the photo or use the provided sliders to
manually control the colour and lighting aspects of your photo.
Fill light
Highlights
Shadows
Highlights
Colour temperature
Neutral colour picker

Effects tab
The Effects tab contains 12 effects that you can apply to any still photo.
Click a button below to learn about each effect:
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Add captions
Tell the story behind a photo using captions. While editing a photo, click the
text underneath that says 'Make a caption!', then add a caption. If you
upload the photo to Picasa Web Albums, your captions will also appear in your
online albums.
Captions are searchable from the top search bar within Picasa. Locate photos
with ease by searching through your photos by the captions that go along with
them.
Sync your edits
So how do you keep your online photos updated with your most recent Picasa
edits? By enabling Sync to Web for a folder or album, edits made to your
photos in Picasa will be reflected immediately in your online Picasa Web
Album. In addition to photo edits, you can sync the changes you make to
captions, tags, and geotags. Learn more about syncing your photos online.
You can also control many of your online album settings directly from Picasa.
Use the down-arrow menu
to the right of the Share button to control
online album privacy, online image size, and much more. Learn more about the
different types of online controls.

Sharing in Picasa
Now that you've organized and edited your photos, you're ready to share
them with others. If you'd like to share an entire folder or album, click the
Share button
located in the folder or album header. Your photos
will then be uploaded to Picasa Web Albums. You'll also be prompted to send
email invitations to your friends and family to view the album.
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You can also use the button bar at the bottom of your Library to share your
photos in creative ways. Just select the photos you'd like to share and click
the action you'd like to take. You can email or upload your photos, create a
collage or movie, or order prints online from any number of providers.
Click a button in Picasa to see a short description of its function,
examples below:
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Backing up your photos
Backing up your photos is a good way to make sure that they're always safe
and sound. Picasa makes it easy to do this. Just click the Tools menu, select
Backup Pictures, and select New Set to get started.
External hard drive: If you have a large collection of photos, you may want
to store your backup file on an external hard drive to save some room on your
local hard drive. Once you've initially backed up your entire collection, Picasa
will then only back up the recent changes that you've made. This saves you
time and ensures that your entire collection will be protected. Using an
external drive with Picasa's backup feature is also a great way to migrate
your photos to a new computer.
Back up to CD or DVD: Burning your photos to CD or DVD is also a
convenient option. Should your hard drive ever fail, or should a power surge
hit your external drive, you will thank your lucky stars as you recover all of
your photos and edits.
Printing your photos
In the era of digital pictures, sometimes it's gratifying to see and hold a hard
copy of a photo. Picasa makes it easy to print your photos at home or order
prints online through your choice of print providers.
The Print button lets you print your selected photos using a local or
networked printer. You can select a print layout size, such as 4 x 6 or wallet
size, and Picasa will automatically size your selected photos to those
proportions. Opt to include a border or your photo captions. These print
layout options make it easier to print multiple photos on one page.
Click the Shop button (Windows only) to access a list of Picasa's online print
providers.
After you sign in to the provider's website, Picasa will
automatically upload all of your selected photos to the print provider's
website, enabling you to order prints as you wish.
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Picasa Photo Viewer
Want to quickly preview your photo? Picasa Photo Viewer is installed with
Picasa and lets you quickly view photos on your computer desktop or in
Windows Explorer. This lightweight application gives you access to view,
make minor edits, and upload an image to your Picasa Web Albums without
having to fully open Picasa. You can set the Picasa Photo Viewer to be the
default photo viewer for all photo file types supported by Picasa.

Please note that the section on Picasa was taken from the
Picasa help web site.
All blue underlined sections are links to specific areas of the
Picasa help site.
The main Picasa web site help can be found here:
https://support.google.com/picasa/?hl=en-GB#topic=4538690
And from within the Picasa program its self
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